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The help file contains a complete list of all Help topics available for the FindRGB application.  
You can use the scroll bar to see the entries that are not currently visible in the Help window.

For information on how to use Help, press F1 or choose Using Help from the Help menu.
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Overview

FindRGB is a graphic SHAREWARE windows util. that lets you match the colors you 
like and find what RGB combination makes them.
FindRGB lets you choose from a color palate or you can create your own colors  using 
the scroll bars .
You can choose the color you like as a background color, and than match another color as a 
foreground color, and see how they look together right away.

FindRGB is a MUST HAVE tool for anyone who designs and write user interfaces and deals 
with graphic elements programming, FindRGB saves those HUGE amount of hours 
trying to find the right color and match the colors together.

FindRGB application has a very intuitive and simple to operate user interface, yet a 
very powerful one that lets any user novice to guru use the program in just a meter of 
seconds, just run it and match the colors...



How To Use FindRGB

FindRGB lets you choose from a color palate (the one in the bottom of the screen) by 
clicking the mouse on one of the colors there, or you can create your own colors using the 
scroll bars (one for the Red, one for Green and the 3rd for Blue).
You can choose the color you like as a background color, and than match another color as a 
foreground color, and see how they look together right away.

You can switch between modifying the background color and the foreground color by clicking
on the Background or the Foreground radio buttons in the target group on the top left side in
the applications window.

The values for the RGB intensity are on the left side of each scroll bar.
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Why and how to register

Simply fill up the ORDER.TXT file and send it with the registration fee.

Registering brings with it a number of advantages.

 o All the Unregistered Copy notice will no longer appear.

 o You will receive a manual.

 o Next major version is sent automatically when it becomes available.

 o If you supplied an E-Mail account a notice for each version release will be sent to you.

 o You will have FREE technical support should you have any problems.

o Your support will encourage me to continue to improve the product FindRGB

 o You will have the knowledge that you personally helped a fledgling software developer 
and furthered the SHAREWARE concept.

 o As I see it, by using this FindRGB software you are saving yourself a lot of trail and error 
hours trying to Find the colors you like and match them together. so this small registration 
fee is really a small one to pay comparing to the benefits that the product FindRGB brings 
you.

So make sure you complete the registration form (ORDER.TXT) as completely as possible 
and sent it.

CompuServe Registration: To have the registration fee added to your CompuServe 
bill type GO SWREG and at the ! prompt follow the menus. FindRGB registration id is 6316

Mail Registration:

For your ease here is a copy of the file ORDER.TXT

FindRGB (R) version 1.0
Copyright (C) 1995 Yonat Dascalu.
All Rights Reserved

      FindRGB v1.0 ORDER FORM
FindRGB Copyright (C) 1995 Yonat Dascalu. All Rights reserved

Payment can be in Cash, money order & checks, Payments in checks must be in US dollars 
drawn on a US bank or Israeli shekels drawn on a Israeli bank, CASH payment can be in ANY 
currency whatsoever, and should be sent to:

Yonat Dascalu
10 Azmaut Street
Ness-Ziona 74010
ISRAEL

Please try to pay in cash for small orders, if you are paying with checks most of the money 
goes to the bank it self due to the bank commissions.



Site licenses:    a site license for FindRGB entitles an organization to receive one copy of the 
distribution package and duplicate the distribution disk for the specified number of copies.
all dollars are US dollars.

FindRGB Single Copy        ____        copies at $19 each = ______

FindRGB Site License
        2 to      9 computers: ____ computers at $15 each = ______
    10 to    24 computers: ____ computers at $12 each = ______
    25 to    49 computers: ____ computers at $10 each = ______
    50 to    99 computers: ____ computers at $8 each = ______
100 to 199 computers: ____ computers at $6 each = ______
more than 199 copies: ____ computers at $5 each = _______

[ ] I would also like to get _____ Win-eXpose-I/O at $29 each = _____
[ ] I would also like to get _____ PrintOut at $29 each = _____

Total payment                          ______

 (Just for example, if you would like to buy 27 copies then the Total payment
      will be :        27 copies x    10$    = 270 $
 )

3.5" disks are sent unless a 5.25" disk is requested.

Note: Please print your name/company name clearly as your
                            registration number will be based on it.

                        Name: ______________________ Date:___________

                  Company: _______________________________________

                  Address: _______________________________________

City, State, Zip: _______________________________________

                  Country: _______________________________________

              Day Phone: ______________    Eve:    _________________

Electronic Mail address: ________________________________

How did you hear about FindRGB? __________________________

Suggestions, changes or additions you would like to 
see in future versions ?

Comments:

Any questions about the status of the shipment of an order,



refunds, registration options, product details, technical support,
volume discounts, dealer pricing, site licenses, etc., must be
directed to :

Yonat Dascalu
10 Azmaut Street
Ness-Ziona 74010
ISRAEL

or by EMAIL to :
75037.725@compuserve.com

All of our software is user supported. Please help us by sending your
comments, suggestions, and changes or additions you would like to 
see in future versions. Please send us a report if you happen to
find a bug.



License Agreement

FindRGB (R) version 1.0
Copyright (C) 1995 Yonat Dascalu.
All Rights Reserved.

For ordering information, see the file ORDER.TXT.

                                                      FindRGB For Windows
                                                                Version 1.0
                                                                          License Agreement
                                                                       Effective Jun. 1st 1995 

 License Agreement

The use of FindRGB is subject to the following terms and conditions.

Title To The Licensed Software

Title to the licensed software is NOT transferred or sold to the end user.
The end user is granted a non-exclusive license to use the software
on a SINGLE computer or computer work station. EACH computer or computer work station 
must have its own licensed copy of the software.

Copyright Protection

FindRGB is copyrighted material. It is protected by the copyright laws of the United States, 
the State of California, and other proprietary rights of Yonat Dascalu. You may not make any 
changes or modifications to FindRGB or this manual. You may not decompile, disassemble, or
otherwise reverse-engineer the software in any way.

You may make copies of FindRGB only under the terms of the section entitled "Limited 
License To Copy The Licensed Software".

You may use FindRGB on a thirty (30) day trial basis only, provided you do not violate the 
protection afforded the licensed software by the copyright laws, and you agree to the terms 
of the license agreement. 
If you use FindRGB past the 30 day evaluation period you are
required to purchase it by paying the registration fee.

Limited Warranty

Yonat Dascalu does not warrant that the licensed software will meet your requirements or 
that the operation of the software will be uninterrupted or error free. The warranty does not 
cover any media or documentation which has been subjected to damage or abuse by you or 
others.
The software warranty does not cover any copy    of the licensed software which has been 
altered or changed in any way. In other words, there is no warranty either implied or 
expressed.

ANY IMPLIED WARRANTIES INCLUDING ANY WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE ARE LIMITED TO THE TERM OF THE EXPRESS WARRANTIES. 
Some States do not allow limitations on how long an implied warranty lasts, so the above 
limitation may not apply to you.



Other Warranties
The warranties set forth above are in lieu of any and all other express or implied warranties, 
whether oral, written, or implied, and the remedies set forth above are the sole and 
exclusive remedies.

Limitation Of Liability
Yonat Dascalu is not responsible nor liable in anyway for any problems or damage caused by
the licensed software that may result from using the licensed software. This includes, but is 
not limited to, computer hardware, computer software, operating systems, and any 
computer or computing accessories. End user agrees to hold Yonat Dascalu harmless for any
problems arising from the use of the software.
Yonat Dascalu SHALL NOT IN ANY CASE BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR DAMAGES ARISING FROM ANY BREACH OF 
THESE WARRANTIES EVEN IF Yonat Dascalu OR ITS AGENTS OR DISTRIBUTORS HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THIS AGREEMENT SHELL BE GOVERNED 
BY THE LAWS OF ISRAEL AND SHELL INURE TO THE BENEFIT OF Yonat Dascalu AND ANY 
SUCCESSORS, ADMINISTRATORS, HEIRS, AND ASSIGNS. ANY ACTION OR PROCEEDING 
BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT OR RELATED TO THIS 
AGREEMENT SHALL BE BROUGHT ONLY IN ISRAEL. 

In no case shall Yonat Dascalu's liability exceed the license fees paid for the right to use the 
licensed software, or a sum no greater than
one Dollar ($1.00), whichever is less.

Limited License To Copy The Software
You are granted a limited license to copy FindRGB ONLY FOR THE TRIAL USE OF OTHERS 
subject to the terms of this software license agreement described herein, and that the 
conditions described below are met.

 -> No fee, charge or other compensation may be accepted or requested by    anyone 
without the express written permission of Yonat Dascalu. 

 ->    Public Domain Disk Vendors May NOT CHARGE a fee for the FindRGB itself. However you
may include FindRGB on a diskette/CD-ROM for which you charge a nominal distribution fee. 
The purchaser of said diskette must be informed in advance that the fee paid to acquire the 
diskette does NOT relieve said purchaser from paying the Registration Fee for FindRGB if said
purchaser uses FindRGB.
          
->      The statement of SHAREWARE registration requirements MUST be printed on a label, or
other form, that is directly attached to the distribution media.

 -> Operators of electronic bulletin board systems (Sysops) may post
FindRGB for downloading by their users without written permission
ONLY AS LONG AS THE ABOVE CONDITIONS ARE MET.    A fee may be charged for access to 
the BBS AS LONG AS NO SPECIFIC FEE IS CHARGED FOR DOWNLOADING FindRGB files 
without first obtaining the express written permission from Yonat Dascalu to charge such a 
fee.

Evaluation and Registration

This is not free software.    This license allows you to use this
software for evaluation purposes without charge for a period of 30
days.    If you use this software after the 30 day evaluation period
a registration fee of 29 US Dollars is required.    Payment can be in
Cash, money order, checks Payments in checks must be in US dollars drawn on a US bank or



Israeli shekels, cash payment can be in any currency. Payments should be sent to:

Yonat Dascalu
10 Azmaut Street
Ness-Ziona 74010
ISRAEL

Quantity discounts are available, as described in the section
Ordering Information/Order Form.    When payment is received you
will be sent a registration key to remove all unregistered messages and documentation and 
the next version of FindRGB.

One registered copy of FindRGB may either be used by a single person who uses the 
software personally on one or more computers, or installed on a single workstation used non
simultaneously by multiple people, but not both.

You may access the registered version of FindRGB through a network, provided that you 
have obtained individual licenses for the
software covering all workstations that will access the software
through the network.



Exit

Exit allows you to exit FindRGB.

To exit FindRGB:

Select the Exit option from the File menu.



Help

Help allows you to het help on using FindRGB FindRGB.

To get help using FindRGB:

Select the Help option from the Help menu.



Registration

Use this screen after registering as a user, by filling the information on this screen all 
"Unregistered copy" messages will disappear.
On information how to register look at this help file under the "How to register" section.



About FindRGB

Select the About FindRGB... option from the Help menu for more information about the 
program.    Choose the OK button to continue.



Troubleshooting

If you experience difficulties using the FindRGB application, refer to the following items:

            Verify that the installation and setup verification steps have been successfully 
completed.

            Ensure that your windows environment supports the number of colors you want to use

          Read all relevant help information.



Need Windows consulting?
Yonat Dascalu is providing worldwide consulting for Windows programming, GUI building, 
MFC, C++, C, Assembly, Visual basic, Windows Device Drivers (VxDs), Multimedia and 
network programming.

For more information:

Yonat Dascalu
10 Azmaut Street
Ness-Ziona 74010
ISRAEL

or by EMAIL to :

75037.725@compuserve.com



Win-eXpose-I/O

Win-eXpose-I/O is a file I/O Tracing/Debugging SHAREWARE windows util. that lets you
examine in real time what files each running application is using or trying to use.
Win-eXpose-I/O traces all the file activities in all the application and in all the different 
VM (even DOS boxes) and gives you a clear picture on problems troubleshooting (like
where and what the hell is the help file / INI file that the application is using or complaining 
that is missing).
Win-eXpose-I/O is a MUST HAVE tool for anyone who is installing windows software on the 
computer or just trying to make sure the current software is working properly, Win-eXpose-
I/O saves those HUGE amount of hours trying to configure new or existing software by 
letting you know in real time what files each application is using or seeking.
Win-eXpose-I/O application has a very intuitive and simple to operate user interface, 
yet a very powerful one that lets any user novice to guru use the program in just a meter 
of seconds, just run it and then activate the other applications and you will see on the Win-
eXpose-I/O screen a real-time logging of all the file activities and their results.
Win-eXpose-I/O is also used as a GREAT performance improves by letting you know for 
each application all the file seeking failures (like searching for a file on the path) and then 
just by changing a few system settings like PATH or working directory you will gain a 
performance improvement.

You can order a copy of Win-eXpose-I/O using this software order 
form (ORDER.TXT).



PrintOut

PrintOut is a Flexible text file printing SHAREWARE windows util. that lets you 
print text file in different formats.

PrintOut lets you even couple a few pages in one printer page to save you money 
and make maintaining hard copy documents and source files easier.

PrintOut Also Supports Background Printing to save you time and allow multitasking, it
also supports Drag and Drop in order to make file printing and multiple file printing 
easier, this version also supports Command Line Parameters to automate tasks and
enable PrintOut to work from batch and script files.

PrintOut is a MUST HAVE tool for anyone who prints text files in any form, its flexibility 
and ease of use will save you a lot of time and money.

PrintOut application has a very intuitive and simple to operate user interface, yet 
a very powerful one that lets any user novice to guru use the program in just a 
meter of seconds

You can order a copy of PrintOut using this software order form 
(ORDER.TXT).






